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Resumen

Se determind un modelo matematico para estimar el area foliar de Carajpa utilis Vasquez en base al largo y
ancho de la lamina foliar en el Bosque sobre arena blanca de la Reserva Nacional Allpahuayo Mishana. Se
realizd el inventario de los individuos mayores a 10 cm de DAP de Caraipa utilis Vasquez en 1 ha. Después se
selecciond al azar 10 arboles, colectdndose 50 hojas/arbol, evaluando al largo, ancho y largo por ancho. El
largo promedio fue de 74,95 mm, con un ancho promedio de 32,55 mm. El area foliar calculada fue 1474,64
mm?, lo cual corresponde al tipo macrofila. Se desarrolld6 dos modelos matematicos: El modelo lineal (AF =
281,757 + 0,473284 LxA, R? = 0,774), sugerido para investigaciones que no requieran un grado de precision
elevado en la estimacion de los datos. El segundo modelo es el cuadratico (AF = 63,205 + 0,63066 [xA —
0,0000238549 [x4°, R? = 0,783), recomendado en investigaciones que requieran mayor precision en la
obtencion de datos. Los modelos propuestos son validos para esta especie, ya que tienen precision, son
practicos y faciles de medir, pero la eleccién del modelo a utilizar, dependera del criterio del investigador y el
propésito del estudio.

Palabras clave: Bosque sobre arena blanca, Lamina foliar, Macrdfila, Modelo matematico del area foliar.
Abstract

A mathematical model was determined to estimate the leaf area of Carajpa utilis Vasquez based on the length
and width of the leaf blade conducted at a Varillal of the Allpahuayo Mishana National Reserve. The inventory
of individuals bigger than 10 cm DBH of Carajpa utilis Vasquez carried out in 1 ha. Then randomly were
selected 10 trees, collecting 50 sheets/tree, evaluating the long, wide and long by wide. The average length
was 74.95 mm, with an average width of 32.55 mm. Leaf area was calculated 1474.64 mm? (Macrophyla
type). Two mathematical models were developed: The linear model (AF = 281.757 + 0.473284 [xA, R? =
0.774), suggested for research that does not require a high degree of accuracy in the estimation of data. The
second model is the quadratic (AF = 63.205 + 0.63066 /x4 - 0.0000238549 [x4, R? = 0.783), recommended
for investigations that require great accuracy collecting data. The proposed models are valid for this specie,
because they have precision, are practical and easy to measure, but the choice of model to be used, depends
on the judgment of the researcher and the study's purpose.

Key words: Leaf blode, Macrophyla, Mathematical model of leaf area, White sand forest.
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INTRODUCCION

De los bosques sobre arena blanca,
localmente conocidos como Varillales, son
extraidas recursos para la construccién de
viviendas rurales y urbanas, ya que se utiliza,
por ejemplo, la madera redonda para la
construccion de viviendas (De Onate-Calvin et
al., 2013; Espiritu y Panduro, 2010; Vasquez,
1997), entre las especies utilizadas esta
Caraipa utilis (Vasquez, 1991), conocidas
localmente como  aceite caspi; es
notoriamente abundante (Zarate et al., 2015).
Esta especie ha estado siendo extraida
notoriamente, lo cual ha conllevado ser
considera como especie Vulnerable (D2) y
Vulnerable (vu) por la UICN y el D.S N© 043-
2006-AG, respectivamente. Y ademas no se
encuentra considerada en un marco legal en
el Perl por la falta de normativa para los
recursos forestales considerados madera
redonda.

La especie Carajpa utilis fue descrita por
Vasquez (1991); corresponde a un arbol de
todos los estratos en los Varillales, inclusive es
el arbol emergente que puede llegar a los 30
m de altura, con tronco recto y con
secreciones aceitosas en la corteza al corte,
tiene hojas simples alternas 5-10 (17) x 2,3-
4,2 (5,5) cm; las flores estan arregladas en
paniculas o  racimos, sépalos de
aproximadamente 2,5 mm de largo, pétalos de
aproximadamente 7-10 mm de largo; los
frutos son capsulas asimétricas, de 15-20 mm
de largo (Vasquez, 1991). Es una especie
endémica (Ledn, 2006) muy abundante y
representativo de los Varillales (Zarate et al.,
2013; Fine et al, 2010; Honorio et al., 2008;
Garcia et al, 2002; Galan de Mera, 2001;
Freitas, 1996). Zarate et a/. (2006) publicaron
datos sobre su fenologia; y Zarate et al
(2015), Vasquez (1991) y Vasquez (1997)
presentan informacidn morfolégica para la
identificacion de la especie.

En el estudio de la ecologia de las especies,
uno de los aspectos mas importantes es
encontrar métodos faciles y econémicos para
estimar el area foliar de las hojas. El area foliar
corresponde a la superficie que ocupa dentro
de los limites de un lado de la hoja. Esta
relacionado con el crecimiento, fotosintesis,
procesos transpiratorios, produccion de
biomasa, entre otros (Pandey y Singh, 2011;
Kleiman y Aarssen, 2007; Yates et al 2009).
Esta drea guarda una relacidn estrecha con
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sus parametros de largo y ancho, y dicha
relacion puede ser descrita mediante
ecuaciones de regresion (Meza y Bautista,
1999). Los modelos matematicos basados en
las medidas de las hojas representan métodos
econdmicos y rapidos para determinar el area
foliar.

A nivel internacional existen muchos trabajos
de la medicion del area foliar de varias
especies, pero solo se realizd en especies que
se cultivan por su demanda alta en el
mercado, y esos trabajos estan orientados a
evaluar el crecimiento y la produccion de
frutos o flores, asi tenemos el frijol (Phaseolus
vulgaris), café (Coffea arabica), girasol
(Helianthus annuus), tomate (Lycopersicon
esculentum); maiz (Zea mays), soya (Glycine
max), caupi (Vigna unguiculata), entre otras
(Warnock et al, 2006; Favarin et al., 2002;
Astegiano et al, 2001; Gonzalez y Garcia,
1996; Duarte et al, 1995). Mientras que no
existen trabajos (0 son muy pocos) en
especies silvestres, como el de Cabezas-
Gutiérrez et al., 2009. Por otra parte, existen
pocos trabajos en area foliar realizados en el
Perl; entre ellos tenemos a Artavia et al
(2004) quienes midieron el area foliar de
Duroia hirsuta en el departamento de Loreto;
Soplin et al. (1993) calcularon el area foliar de
Zea mays (maiz) y Arachis hypogaea (mani),
también en el departamento de Loreto; y
Yzarra et al. (2009) midieron el area foliar de
Zea mays (maiz) en el departamento de Lima.
Por lo cual en el presente trabajo buscamos
determinar el area foliar y cuantificar un
modelo matematico para estimar el area foliar
de las hojas de Carajpa utilis Vasquez en base
a los parametros de largo y ancho de la lamina
foliar en un Varillal de la Reserva Nacional
Allpahuayo Mishana, Loreto, Peru.

MATERIAL Y METODOS

Area de estudio

La investigacién se realizd cerca del Km 31,5
de la carretera Iquitos - Nauta, con
coordenadas UTM 672771 N y 9559046 E
(Zona UTM 18M) dentro de la Reserva
Nacional Allpahuayo Mishana, del
departamento de Loreto de la Republica del
Per( (Figura 1); el muestreo se realizd en
Noviembre del 2013.
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Herborizacion de muestras botanicas

Las muestras de plantas fueron identificadas
en el Herbario Amazonense y con las claves de
Vasquez (1991), Vasquez (1997) y Zarate et
al. (2015). Y se encuentran dentro de las
colecciones de plantas del Instituto de
Investigaciones de la Amazonia Peruana.

Medicion del drea foliar

Se selecciond al azar 10 arboles mayores de
10 cm de DAP en 1 ha, se colecté 50 hojas por
cada arbol. Luego se procedié a medir el largo
y ancho de la lIdmina foliar. Las hojas fueron
colocadas sobre una cartulina rosada cubierta
por un vidrio de 10 x 12 cm para expandirla,
sefalando sobre la cartulina una medida de
referencia de 50 mm. Después, las hojas
fueron fotografiadas a una distancia de 15 cm
utilizando una camara Sony de 12 Mp fijada a
un soporte universal. Las fotografias fueron
calibradas de manera individual, segun lo
propuesto por Rincén et al (2012), en
Image]® 1.v8, siguiendo la secuencia: Analyze
> Set scale > Know distance: 50, Unit of
length. mm. Para procesar la imagen se utilizo
la siguiente secuencia: Image > Type > 8 -
bit, Image > Adjust > Threshold. Después
para calcular el area foliar individual se
procedid de la siguiente manera: Analyze >
Measure.

Andlisis de datos y modelos matematicos del
area foliar

Se aplico el analisis de correlacién de Pearson
entre la longitud y ancho con el area foliar
calculada por Imagel®, para seleccionar el
parametro con mayor correlacion de acuerdo
a Pire y Valenzuela (1995), que permitio
construir modelos matematicos mediante
regresiones de tipos lineales, cuadraticas,
Cubicas y logaritmicas. Para seleccionar el
modelo con mejor ajuste, se realizd un analisis
de correlacién lineal entre los valores
estimados y los valores promedios del area
foliar y tomo en consideracion el modelo con
mayor coeficiente de determinacion (R?).

RESULTADOS

El largo minino de la lamina foliar de Caraipa
utiles fue de 26,38 mm, con una maxima de
137,10 mm, teniendo un promedio de 74,95
mm. Para el ancho, se registré como el minimo
valor a 16,30 mm, mientras que 76 mm fue el
maximo, con un promedio de 32,55 mm. El
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area foliar vario de 148,97 a 3920,61 mm?, con
un promedio de 1474,64 mm?. El coeficiente
de variacién del area foliar fue 38,53% (ver
mas detalles en la Tabla 1).

Los modelos de regresiones lineales
presentaron R? superiores a 0,650, pero
inferiores a 0,775, indicando que existe una
relacibn de positiva alta a positiva
moderadamente alta entre las variables
(p>0,05). El largo como variable
independiente, presentd un mejor ajuste
respecto a ancho, asi el modelo I (AF = -
765,793+298,892L) tuvo un R? de 0,701,
superior al R? de 0.601 del modelo II. El
modelo VI, con el LxA?> como Vvariable
independiente, presento el R?> mas bajo
(0,657) con el Sx mas alto con 333.316. El
modelo lineal que presenta mejor ajuste para
estimar el area foliar fue el III (AF = 281,757
+ 0,473284LxA), con un coeficiente de
determinacidon positiva moderadamente alta
de 0.774, y con el Sx mas bajo (270,484).
Estos detalles estan indicados en la Tabla 2.
El modelo III fue sometido a un analisis de
regresion y varianza (Tabla 3) con carencia de
ajuste, para determinar si el modelo propuesto
es adecuado a un nivel de confianza de 95%.
El modelo de correlacion lineal presenta un
coeficiente de correlacion de 0.880, indicando
una relacion moderadamente fuerte entre las
variables. El analisis de regresién muestra que
el modelo explica el 77,4% de la variabilidad
en el area foliar calculada a partir del producto
del largo por ancho de la hoja. El analisis de
varianza del modelo muestra que existe una
relacion estadisticamente significativa entre
las variables con un nivel de confianza del
95%, lo cual indica que la funcién es adecuada
para describir los datos observados.

Se elabor6 un grafico de residuos
estudentizados para determinar la existencia
de valores outliers o influyentes en el modelo
III. La Figura 1 muestra que la distribucion de
los residuos estandarizados es independiente
al nimero de las hojas de Caraipa utilis
Vasquez, notando la presencia de estos
valores (Tabla 1). Debido a esto, se calculd el
area foliar de las hojas de Caraipa utilis
Vasquez en base al producto del largo por
ancho de la ldamina foliar, mediante ecuaciones
de regresiones polindmicas (Tabla 4).

El menor R? corresponde al modelo cuadrado
de X con 0,657, seguidos de modelo
exponencial con un R? de 0,687. Hay dos
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modelos que presentan los R? mas elevados,
el cuadratico y cubico con 0,783, siendo el
cuadratico el que presenta un menor error
estandar de estimacion de 265,539. De esta
manera se determind que el modelo
cuadratico presenta un mejor ajuste para
estimar el area foliar en Caraipa utilis Vasquez
(Tabla 4).

Después se realizd un analisis de correlacién
lineal entre los valores estimados y los valores
promedios del area foliar para validar los
modelos propuestos. La comparacion entre los
datos medidos y los datos estimados del area
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foliar mediante el modelo lineal tuvo un R igual
de 0,8796, indicando una correlacion positiva
alta entre las variables. El R? indica que el
modelo puede ser utilizado para la estimacion
del area foliar de Caraipa utilis\Vasquez (Figura
2a). El modelo cuadratico un R mayor con
0,9992, demostrando una correlacion positiva
muy alta entre los valores medidos vy
esperados. El R? de 0,9986 entre los valores
medidos y esperados, fundamenta el uso de
este modelo con mayor seguridad y precision
(Figura 2b).
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Tabla 1. Longitud y area foliar de las hojas de Caraijpa utiles Vasquez en el Varillal.

Valor Valor

. . Ay ‘s Promedio ) Coeficiente
Parametro Hojas minimo maximo ) S .
(mm/ mm?)  (mm/ mm2) (mm/ mm?) de variacion
Largo 500 26,38 137,10 74,95 253,11 21,23%
Ancho 500 16,30 76,00 32,55 56,11 23,01%
kircgh%por 500 493,83 8445,36 2520,02  1115149,98  41,91%
’é;lecilgoc'j':r 500 148,97 3920,61 1474,64 322806,19 38,53%

Tabla 2. Regresiones lineales en base al largo, ancho y largo por ancho de las hojas de Caraipa utilis
Vasquez en el Varillal.

. | i Coeficientes
Numero de modelo Funcion A B R2 Sx
I AF=a + bL -765,793 298,892 0,701 311,256
II AF=a + bA -439,959 588,167 0,601 359,121
I1I AF = a + b(LxA) 281,757 0,473284 0,774 270,484
v AF=a + bL(LxA) 720,012 0,00370156 0,751 284,013
v AF= a + bA(LxA) 819,52 0,00733647 0,668 327,744
VI AF = a + b(LxA)? 1004,41 0,0000629788 0,657 333,316

Tabla 3. Andlisis de regresion y varianza del modelo lineal seleccionado.

Andlisis de regresion del modelo

R = 0,880 R? = 0,774 Reorreg, = 0,781 Sx = 270,484
Modelo matematico y = 281,757 + 0,473284 x
Andlisis de varianza con carencia de ajuste del modelo
Suma de Gl Media cuadratica F Sig,
cuadrados
Regresién 1,24646E8 1 1,24646E8 1703,71 0,0000
Residuo 3,64344E7 498 731614
Total
(Corre,) 1,6108E8 499

Tabla 4. Regresiones polindmicas para calcular el area foliar de las hojas de Caraijpa utilis Vasquez en el

Varillal.
Tipo de regresion R? Sx Modelo matematico
Cuadratica 0,783 265,539 Y = 63,205 + 0,63066 X - 0,0000238549.%2
Cubico 0,783 265,645 Y=-11,443 + 0,710 X- 0,00005 X?- 0,000000002 X°
Logaritmica 0,742 288,641 Y = - 7986,493 + 1220,06 LnX
Exponencial 0,687 0,218 Y = exp(6,45317 + 0,000305594 X)
Multiplicativo 0,760 0,191 Y = exp(0,668808 + 0,845517 LInX)
Doble cuadrado 0,747 1,0359E6 Y= sqrt(695073 + 0,24132 X
Cuadrado de X 0,657 333,316 Y= 1004,41 + 0,0000629788 X2
Raiz cuadrada doble 0,781 333,316 Y= (6,21431 + 0,640224sqrtX)?
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Figura 2. Area foliar medida y area foliar estimada de Caraijpa utilis a) Regresion simple, b) Regresion simple

DISCUSION

Las hojas de Caraipa utilis\Vasquez presentaron
un largo promedio de 74,95 mm, con variacion
entre 137,10 mm y 26,38 mm, mientras que el
ancho de la lamina foliar presento un promedio
de 32,55 mm, entre los 16,30 mm y 76 mm
(Tabla 1). Datos similares han sido registrados
por Vasquez (1997), en una investigacion
realizada en la misma d&rea de estudio,
encontrd que las hojas de esta especie tienen
entre 50 mm y 100 mm de largo, y 23 mm a
42 mm de ancho. Estas son las Unicas medidas
registradas de las hojas de Caraipa utilis
Vasquez, desconociéndose su area foliar hasta
el presente trabajo (No hay publicados datos
del area foliar de Carajpa utilis Vasquez,
aunque podemos afirmar que los resultados
estan dentro de los esperado en comparacion
con otras especies similares). EI mismo autor
registrd valores superiores para las hojas de
otras especies del género Caraijpa en el Peru
(Tabla 5), de los cuales, los valores mas altos
pertenecen a Caraipa grandiflora con 160 mm
a 280 mm, y 55 mm a 90 mm de ancho. Otros
valores similares fueron registrados para
especies del genero Carajpa fuera del Perd, tal
es el caso Carajpa andina Aymard en los andes
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venezolanos, que tiene una longitud de hoja
que varia entre los 60 mm a 90 mm, y un ancho
que va desde los 30 mm hasta los 50 mm
(Aymard y Campbell, 2008).

La similitud en el tamafio de las hojas en las
especies del género Caraipa indican que los
factores extrinsecos no tienen mucha influencia
en el tamafio de estas, porque especies con
tamafio de hojas similares a Caraipa utilis
Vasquez, como Carajpa jaramilloi y Carajpa
valioi se desarrollan en otro tipo de bosques
(Vasquez, 1997) bajo condiciones ambientales
diferentes con dimensiones similares en sus
hojas. Son los factores intrinsecos, limitaciones
fisicas impuestas por la altura del arbol o el
peso de las hojas, los que parecen condicionar
el tamafio de las hojas en esta especie (Jensen
y Zwieniecki, 2013), ya que el simple hecho de
la facil captura de luz deberia favorecer hojas
pequefas y de igual tamafio en especies que
predominan en los estratos por encima de los
20 m en el Varillal y que se ubican a la misma
altura, como lo son Pachira brevipes'y Caraipa
utilis Vasquez (Zarate et al, 2015), situacion
que no ocurre.

Siguiendo el método propuesto por Rincén et
al. (2012), se calculé que el area foliar tuvo un
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valor promedio de 1474,64 mm?, variando
desde los 148,97 mm? hasta los 3920,61 mm?
(Tabla 1). De acuerdo a la clasificacion de hojas
propuesto por Webb (1959), las hojas de
Caraipa utilis Vasquez se encuentran dentro la
categoria 6, tipo macrofila.

En concordancia a Sepulveda y Kliever (1983),
quienes afirman que se puede estimar el area
foliar mediante ecuaciones de regresion
utilizando el largo, ancho y largo por ancho de
la hoja, se desarrollé modelos matematicos en
base a regresiones lineales simples. Los
modelos de regresiones lineales presentaron R?
superiores a 0,650, pero inferiores a 0,775,
indicando que existe una relacién de positiva
alta a positiva moderadamente alta entre las
variables (p>0,05). El empleo del largo como
variable independiente, presento un mejor
ajuste respecto a ancho, asi el modelo I (AF =
-765,793+298,892L) tuvo un R? de 0,701,
mayor a la del modelo II (R? = 0,601). Este
comportamiento ha sido reportado en otros
estudios (Cabezas-Gutierrez et al/ 2009, con
Alnus acuminata, Escallonia pendulay Quercus
humboldtii; Cittadini y Peri, 2006, en hojas de
Prunus avium, Singh, 2007, con Allahabad
Safeda; Nautival et al. 1990, en hojas de Malus
domestica, todas con hojas similares a Caraipa
utilis Vasquez), quienes encontraron que el
largo presenta un mejor ajuste frente al ancho
de la hoja. Por el contrario, en otros estudios
se reportd que es el ancho el parametro que
mejor estima el area foliar (Pire y Valenzuela,
1995) con valores superiores a 0.900 (p = >
0,001).

El modelo lineal que presenta mejor ajuste para
estimar el area foliar fue el III (AF =
281,757+0,473284LxA), con un coeficiente de
determinacién positiva alta de 0,774, y con el
Sx mas bajo (270.484). Respecto al S« del
modelo III, es posible que la amplitud de los
valores LxA sea mayor, y por tanto, el estimado
tiene una alta dispersién y mayor grado de
confiabilidad. La eleccion del LxA para
desarrollar ecuaciones de regresion que
permitan estimar de mejor manera el area
foliar ha sido validada ampliamente en otras
investigaciones (Meza y Bautista, 1999;
Calderén et al 2009; Penton et al. 2006;
Cittadini y Peri, 2006; Singh, 2007; Cabezas-
Gutiérrez et al. 2009). Seguin Lima et al. 2007
en una investigacién con Mangifera indica, la
eleccion de la LxA puede ser justificada debido
a que esta especie no presenta polimorfismo
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foliar en diferentes edades de su crecimiento,
teniendo sus hojas una forma lanceolada
durante todo su ciclo de vida. Respecto a lo
anterior, Hinnah et a/ 2014, menciona que la
forma de la hoja y su variacidn en el periodo de
crecimiento es un aspecto importante en el
desarrollo de modelos de estimacidon. Sin
embargo, desarrollar modelos para cada edad
o tamafo de hojas no es justifica debido a las
pequefas mejorias alcanzadas en la estimacion
del area foliar. Esta explicacion puede ser
aplicada a Carajpa utilis Vasquez, considerando
la forma de la hoja (eliptica) de esta especie.
Utilizando el criterio propuesto por Meza y
Bautista (1999) y Piere y Valenzuela (1995) se
selecciond al modelo III por presentar el mayor
R? y menor Sy. La concentracion de los residuos
estudentizados valida el modelo III (Figura 3),
sin embargo, se puede notar la presencia de
valores outliers e influyentes (Tabla 1). Esto
indica que el modelo, aun presentado un R?
moderadamente fuerte, no puede ser utilizado
para estudios que requieran un alto nivel de
precision en los datos estimados. Debido a los
posibles efectos detener 7 puntos con mas de
5 veces el valor de influencia normal, y 14
puntos con mas de 3 veces el valor de
influencia promedio, se desarrollé regresiones
polindmicas para estimar el area foliar de las
hojas con un mayor grado de precisién (Tabla
6).

De los modelos matematicos construidos en
base al LxA de la ldamina, existen dos modelos
que presentan los R? mas elevados, el
cuadratico y cubico con 0,783, siendo el
cuadratico el que presenta un menor error
estandar de estimacion de 265,539. De esta
manera se determind que el modelo cuadratico
presenta un mejor ajuste para estimar el area
foliar en Caraipa utilis Vasquez. Un resultado
distinto fue reportado por Pentén et a/. (2006),
quienes afirman que el modelo lineal es tiene
un R? marcadamente superior al modelo
cuadratico, probablemente debido a la
diferencia en la forma de las hojas de Morus
albay Caraipa utilis Vasquez. Puesto que en el
modelo cuadratico la significancia es menor a
0,05 (Tabla 4), el andlisis de varianza del
modelo muestra que existe una relacion
estadisticamente  significativa entre las
variables con un nivel de confianza del 95%, lo
cual indica que la funcion Y =
63,205+0,63066X-0,0000238549X? es
adecuada para describir los datos observados
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en estudios que requieren mayor precisién en
la obtencion de datos.

De acuerdo a la validaciéon de los modelos, el
modelo lineal y = 281,757+0,473284AxL vy el
modelo cuadratico Y 63,205+0,63066X-
0,0000238549X? produjeron coeficientes de
determinacién de 0,7738 y 0,9986, lo que
indica que ambos modelos pueden ser
utilizados para calcular el area foliar de las
hojas de Carajpa utilis Vasquez. Para el modelo
cuadratico R? entre los valores medidos y
esperado, fundamenta el uso de este modelo
para con seguridad y precision. La eleccién del
modelo a utilizar dependera del propdsito y
grado de precisién de la investigacion.

Este tipo de métodos ya han sido utilizados y
validados por otros autores en diferentes tipos
de plantas, como cultivos semestrales (Paksen,
2007; De Swart et al. 2004), cultivos horticolas

Area foliar de Caraipa utilis en un varillal de la Reserva Nacional Allpahuayo Mishana

(Gutiérrez y Lavin, 2000; Cittadini y Peri, 2006;
Mendoza-de Gyves et al. 2007) y en algunas
especies lefiosas (Singh, 2007; Broadhead et
al. 2003; Peper y McPherson, 2003).

Las mediciones lineales realizadas a las hojas
no constituyeron muestreos destructivos y a la
vez fueron facilmente realizables, por lo que
estas mediciones pueden ser repetibles en el
tiempo. Asi mismo, la alta correlacién
encontrada entre el producto del largo por
ancho de la lamina y el area foliar hace
apropiados y confiables estos procedimientos
de estimacidn, asi los parametros de longitud y
ancho de la lamina foliar si permiten desarrollar
un modelo matematico para estimar el area
foliar de Caraijpa utilis Vasquez en un Varillal de
la Reserva Nacional Allpahuayo Mishana,
Loreto, Peru.

Tabla 5. Tamaio de las hojas de varias especies de Caraipa.

Especie

Caraipa utilis Vasquez
Caraipa utilis Vasquez*
Caraipa densiflora Mart*
Carailpa jaramilloi Vasquez*
Caraipa tereticaulis Tul,*
Caraipa valioi Paula*
Caraipa punctulata Ducke*
Caraipa grandifolia Mart, *
Caraipa andina Aymard**

Largo (mm) Ancho (mm)
Méximo Minimo Maximo Minimo
137,1 26,38 76 16,3
100 50 42 23
140 55 45 25
120 60 40 20
125 50 50 23
180 130 90 50
210 140 80 50
280 160 90 55
90 60 50 30

* Especies de Caraipa reportadas en Allpahuayo Maishana, Peru por Vasquez (1997).
** Especie de Carailpa registrada en Venezuela por Aymard y Cambell (2008).

Tabla 6. Puntos influyentes en las observaciones del modelo.

Numero X Y Predicciones en Residuos Influencia de los valores
de hoja Y estudentizados
1 8445,36 3920,61 4278,81 -1,37 0,0650946
14 6354,73 3097,68 3289,35 -0,72 0,0284259
19 5656,56 3001,6 2958,92 0,16 0,0196794
23 5233,8 2743,59 2758,83 -0,06 0,0152347
153 7624,2 3725,83 3890,17 -0,62 0,0488185
156 5399,5 2790,39 2837,26 -0,17 0,0169003
169 6871,04 3370,69 3533,71 -0,61 0,036021
173 5572,76 2950,2 2919,26 0,12 0,0187473
182 4938,18 2468,17 2618,92 -0,56 0,0125083
184 5262,4 2486,24 2772,37 -1,07 0,0155151
192 7075,2 3430,78 3630,34 -0,75 0,0392886
193 6536,76 3332,96 3375,5 -0,16 0,0309943
198 4916,29 2566,61 2608,56 -0,16 0,0123189
208 6102,04 1358,11 3169,76 -7,11 0,025058
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Figura 3. Grafico de residuos (Largo por ancho de las hojas).
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